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Introduction

StationManager is designed to be easy and intuitive to use. However, a few general concepts need to be
learned before becoming proficient with the software. There are two ways to get started with
StationManager.

First, this section in the User’s Manual introduces many of the basic concepts required to use
StationManager. Review this section to obtain general information needed to use the software.

The other method is to work the example contained in the Demonstration Guide. The guide will introduce
the basic concepts to create, populate, access, analyze, review, and print a simple example database. If time
is short, we suggest that you start with the Demonstration Guide and then review the contents of the User’s
Manual when more time is available.

System/Hardware Requirements

StationManager™ will operate on any device configured to run Windows 8 through Windows 11. When
installed, the StationManager software will require a minimum of 110 MB of free hard disk space. Each
station will require approximately 19 KB of free hard disk space.

License Management System

StationManager uses an internet-based licensing system. The software can be installed on any number of
devices. License information is stored on a B3PE server. When a User attempts to use the software, the
license availability is checked on the server. If the number of “in-use” licenses is less than the purchased
number of licenses (the User Limit), the User is allowed to continue; otherwise, the use of the software is
denied until the number of “in-use” licenses is below the User Limit.

A license can be “checked-out” for up to thirty (30) days. Once “checked-out,” the license is unavailable for
use by any other Users until the license is checked back “in.” An internet connection is not required to use
the software during the checkout period for the device and User that checked-out the license.

Installing StationManager

An appropriate version of Windows must be running in order to install StationManager. If it is not, start
Windows now, then proceed with the installation process described below.
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You will need to be logged on as the Full Administrator or use the “Run as administrator” option
when executing the installation file.

Note...

On the License Agreement screen, carefully read the Terms Of Use agreement and select the “I
agree to...” option. If you do not wish to accept the Terms Of Use agreement, you will not be able
to continue with the installation process.

Note...

• An appropriate version of Windows must be running before StationManager may be executed.
If Windows is not running, begin its execution now.

• You will need to be logged on as the Full Administrator or use the “Run as administrator”
option the first time you execute the software.

• The device must be connected to the internet the first time that the StationManager software is
executed.

Note...

! Download the compressed folder (.zip) containing the setup executable file from the supplied link to your
device. Navigate to the downloaded file’s location and open or explore it using Windows File Explorer.

! Double-click the setup file’s name in the compressed folder. If a Windows Security warning appears, allow
your device to execute the file.

! After the setup program has been started, several screens will be displayed during the installation process.
Read the contents of each screen carefully and respond appropriately.

! A message will be displayed when the installation process is complete. The message will indicate whether
the installation was successful or whether it failed. Select the appropriate option to clear the message.

Starting StationManager

! From the Windows Desktop, double-click the StatMan shortcut icon.

! The StationManager software will be started, the Welcome screen will be displayed, and the license
subscription will be checked.
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If the device is not connected to the internet, a message stating that the software is “Unable To
Access Validation File” will be displayed. To proceed - connect the device to the internet, then
click the Retry command button.

Note...

! Review the displayed license information, and click the Continue command button to “check out” a license
and enter the software.

Depending on the preference settings, a blank screen may be displayed, or the last opened database will be
displayed. In either case, choose the desired option from the pull-down menus.

User Limit

The number of Users that can simultaneously run the StationManager software depends on the number of
User licenses purchased with the subscription. This number is referred to as the User Limit.

When StationManager is executed, it determines the User Limit associated with the subscription and the
number of Users currently using the software - the Current Users. The Welcome screen displays these values.

If the addition of a new User does not exceed the User Limit, the Continue command button will be enabled,
and you will be able to start StationManager. If the User Limit would be exceeded by allowing a new User,
you will not be able to execute the StationManager software until one of the in-use licenses is returned.
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Database Design

The StationManager software provides the User with a comprehensive predefined database for maintaining
design, operation, inspection, and compliance data associated with pressure-reducing stations. Data is
accessed through an easy-to-use spreadsheet-style interface. The spreadsheet interface is enhanced by several
complementary interface options.

! A pop-up Data Entry Form allows “fill-in-the-blank” access and entry.

! A powerful pop-up Schematic Data Interface allows graphical viewing of data values and results
and point-and-click access to the station data.

Integral to the database is a full calculation engine for performing capacity and pressure calculations to
ensure regulatory and operational compliance.

The StationManager database consists of a group of files containing various values associated with different
aspects of the station data. These include a file containing general database setup and default information,
a file containing general station information, a file containing the data required for the hydraulic analysis,
a file containing inspection results, and a file containing specific equipment information for the pressure
regulating and relief devices. The Station Data file includes a record for each station. Each station record is
linked to the remaining data files, so all data can be accessed based on the selected station record.

StationManager defines a station as a collection of runs, stages, devices, and piping sections. A run consists
of one or more stages. A stage consists of one or more devices and the associated piping sections. A device
is a pressure limiting or overpressure device - regulator or relief valve. Devices are designated as upstream
(regulator) or downstream (regulator, relief valve, or security valve). The piping sections are defined as
upstream (supply or inlet), intermediate (between the upstream and downstream device), downstream (outlet
of station), and stack (outlet of relief valve).

A station can contain one or two runs. A run can have one or two stages. A stage can include one or two
devices. Stages can be configured as regulator only, regulator-regulator, regulator-relief valve, dual regulator-
relief valve, relief valve only, or security valve. Operation schemes for regulator-regulator configurations
can be upstream monitoring - downstream controlling, upstream working monitor - downstream controlling,
upstream controlling - downstream monitoring, or simple first cut - second cut without overpressure
protection.

When two stages are present, the downstream section of the first (upstream) stage is disabled, and the
upstream piping of the second (downstream) stage is assumed to be connected directly to the outlet of the
first-stage downstream device.
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If a stage consists of a regulator only, the downstream device is disabled. The regulator must be assigned as
the upstream device. The intermediate piping is disabled, and the downstream piping is assumed to be
connected directly to the outlet of the upstream device (regulator).

If a stage consists of a relief valve or security valve only, the upstream device is disabled. The valve must
be assigned as the downstream device. The intermediate piping is disabled, and the upstream piping is
assumed to be connected directly to the inlet of the downstream device (relief or security valve).

In addition to the station data, a set of data files referred to as “Property Tables” are also maintained. These
files contain common information about pipe, fitting, regulator, and relief valve properties. The common data
includes values such as inside pipe diameter, equivalent lengths for fittings, and valve factors for the
regulator and relief valves. The User can customize the Property Tables to reflect their specific needs.

Some of the supported station configurations are shown in the following figure.
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In addition to the configurations shown, relief valves can be “shared” between a parallel run and stage or
“combined” on stages in series. Sharing a relief valve refers to the case where regulators in a parallel run and
stage are protected by a single relief valve. The valve is assumed to be installed on one run or the other.
Combining a relief valve refers to the case where an upstream regulator is protected by two (different)
downstream relief valves - the capacity of the relief valves is combined during the compliance check. The
combined relief valves are assumed to be installed in series on the same run.

The device control lines are assumed to be connected as follows:

Control Line Sense Location

Configuration Device Sense Location

Regulator Only Upstream (Control) Inlet of Downstream Piping

Monitor - Upstream Upstream (Monitor) Inlet of Downstream Piping

Downstream (Control) Inlet of Downstream Piping

Monitor - Downstream Upstream (Control) Inlet of Downstream Piping

Downstream (Monitor) Inlet of Downstream Piping

Monitor - Upstream Working Upstream (Control) Inlet of Intermediate Piping

Upstream (Monitor) Inlet of Downstream Piping

Downstream (Control) Inlet of Downstream Piping

First Cut/ Second Cut Upstream (Control) Inlet of Intermediate Piping

Downstream (Control) Inlet of Downstream Piping

Regulator/Relief Valve Upstream (Regulator) Inlet of Intermediate Piping

Downstream (Relief Valve) Outlet of Intermediate Piping

Relief Valve Only Downstream (Relief Valve) Outlet of Upstream Piping

Security Valve Only Downstream (Security
Valve)

Outlet of Upstream Piping
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Sample Database

A sample database is included when StationManager is installed. The database contains sample records for
several of the station configurations supported by StationManager. The database will be automatically
opened when StationManager is first executed. To open the database at other times, use the Open item from
the File menu. The Example section of this Demonstration Guide provides instructions for browsing and
manipulating the database contents. If changes are made to the sample database, the original contents can
be restored using the Restore Samples item from the File menu.

Database Interface

The values contained in the database are accessed through a spreadsheet-style report. The data is grouped
by functionality into separate report sections, which are displayed on separate report tabs. The report consists
of tabs, rows, and columns. Each row represents a record, and each column represents a specific data item.
Each station is represented by a record and a set of sub-records for each run and stage.

Several options are available for viewing and entering data values and results. The primary means of access
is through the Database Report. This access option allows direct access to the data values and results and
provides a variety of data manipulation tools. The Report interface is complimented by several additional
specialized interfaces. The pop-up Data Form allows data to be entered using a fill-in-the-blank style
interface, and the results are presented in a similar style. The pop-up Schematic Data Interface provides
graphical access to the data values and results, allowing point-and-click data editing and graphical display
of the calculation results.

The Station Data Report is the only access option that allows station records to be inserted or deleted.
Records can be added to the end of the database with any edit-enabled interfaces. The report must be open
to access the station data or any of the other data access interfaces. Tools are provided to create a selection
set or sorted set of records, limit the data displayed, to add, enter, insert, and move records, to update values
en masse based on User-defined selection criteria, and save a selected set of data.

Notes On Dimensional Units

When StationManager first starts, its default dimensional units are set to standard US values (feet, inches,
psi, Fahrenheit). However, you will notice that the software supports a variety of dimensional units.

As used in StationManager, all pressure units represent “gauge” units unless otherwise specified. Within the
documentation, gauge pressure units are generally shown without a suffix, and absolute pressure units are
shown with an “a” or “(Abs)” suffix. Gas volume values or volumetric flow rates are expressed in “standard”
cubic units, based on (adjusted to) the specified base pressure and temperature.

 B3PE LLC                                                                                          Engineering & Software Services
Revision - 001, Copyright 2024, All Rights Reserved.

8



StationManager™ 2.1 Getting Started Guide

Notes For International Users

StationManager attempts to accommodate the needs of international Users by providing a robust set of
dimensional units. These units can be selected as appropriate for the User’s particular needs.

StationManager does have a particular weakness when it comes to the various Property Tables that contain
predefined data. These lists are primarily oriented toward US manufacturers and sizes. The Property Tables
can be easily modified by the User to more specifically meet the particular needs of each User. The Property
Tables provided with the software are intended to provide a starting point to allow the User to create their
own custom Property Tables.

Using The Help System

The help documents are stored on a B3PE server. You must be connected to the internet to access the various
StationManager help and support documents.

The StationManager Manual can be used for information on specific screens and commands and detailed
instructions, descriptions, and explanations.

Once a document is opened, it can be saved locally if you wish. If you save a help document to your machine
for offline access, you must open it directly in your Portable Document Format (PDF) document viewer. A
suitable PDF document viewer or reader is required to view and print the documents.

The Help Menu

Access to the various help documents and information is provided in the Help menu. You can also view our
contact information, send a help request, or visit our website. Note - Some of the features require an internet
connection to work properly.

Contact Us

Hours: Our normal work hours are 8:00 A.M. to 5:00 P.M. Mountain Time, Monday through Friday.
However, if you have a problem, please try anytime - we may be in.

Telephone: (719) 578-9391

Email: help@b3pe.com

Website: www.b3pellc.com
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If the Uninstall Program asks to remove any shared system files, click the No command button.
Note...

Exiting StationManager

When the Continue command button is clicked on the Welcome screen to enter the software, a license of the
StationManager software is “checked-out.”

When exiting the StationManager software, there are two options - an option to “return” the checked-out
license or an option to keep the license “checked-out.”

! To return the “checked-out” license, from the Exit menu, click the And Return License item. In
order to return the “checked-out” license, the device must be connected to the internet so that the
User Count can be updated.

! To keep the license “checked-out,” from the Exit menu, click the Without Returning License item.
The User Count will not be updated, and the license will remain “checked-out” until the license is
“returned.” This option allows for the software to be used without having access to an internet
connection for up to 30 days. Select the And Return License item from the Exit menu to return a
“checked out” license.

Releasing Read-Only Database

When a database is opened, it is set as read-only so changes from another User cannot overwrite the current
data values. If the software is terminated without closing the database, the read-only setting will remain. To
release/remove the read-only setting, select the Release Read-Only menu item from the File menu list.

Uninstalling StationManager

If, after using the StationManager software, you wish to remove it, select the Uninstall StationManager 2.1
item from the StationManager Windows Start menu list.

! After the Uninstall Program has been started, read the contents of each screen carefully and respond
appropriately.

! A message will be displayed when the Uninstall routine is complete. The message will indicate whether
the routine was successful or whether it failed. Select the appropriate option to clear the message.
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• On some devices, the Uninstall routine will not be able to remove any directory or file that has
been created after the initial installation.

• Some of the files and folders created by StationManager after the installation may include files
in the initialization directory (ini), files in the default database file directory (files), and files in
the application directory (app).

• To remove these files and folders, use Windows File Explorer to find and delete the remaining
files and folders. An example of the path for the initialization folder is shown below. The other
folders have similar path locations.

• 32-bit machines - C:\Program Files\StatMan 2\ini
• 64-bit machines - C:\Program Files (x86)\StatMan 2\ini

Note...
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